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Lab 1: Excel Basics

Microsoft Excel is a spreadsheet application that is used for basic data organization, statistical analysis,
graphing data as well as many other uses. In this lab, we will take a look at what makes up an Excel
spreadsheet and the basic uses of it.

The interface
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The File-menu: This menu allows you to create, save, open and print spreadsheets.
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Quick access toolbar: You can customize this toolbar to include all of the functions you use most,
such as save and undo.
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The ribbon: The ribbon contains all the office menus and toolbars. The ribbon is divided into tabs,
each of which contains groups of controls.

4. Columns: Label 4 is one of the columns in the spreadsheet. Each column is labeled by the letter (or
a string of letters) at the top of it.
Rows: Label 5 is one of the rows in the spreadsheet. Each row is labeled by the number to its left.
Cells: A cell is the intersection between a row and column. A cell is where most of the excel data is
entered. A cell’s address is the row and column it is in, for instance, the boxed cell (label 6) is in
column E and row 13; hence, its address is E13.




7. The worksheet toolbar: An Excel file is called a workbook. It consists of a number of spreadsheets
(worksheets). This toolbar allows you to move between the different sheets in a workbook. It also
allows you to create new worksheets, delete existing sheets, and rename sheets.

Exercise 1

1. Enter the data “Sunday” into cell A1 and “Monday” into cell B1.
2. Typein “17/08” into cell E8.

3. Typein “2” into cell I8 and “4” into cell 19.

Auto-complete
Your worksheet should now look like this:
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Notice how Excel automatically detected that 17/08 was a date and converted it to 17-Aug. We will
discuss formatting data later on in this lab.

Now, we want to select both cells A1 and B1 together. To do this, click A1 and without releasing the
mouse button, move the mouse over cell B1. Now there should be a rectangle around both cells as
shown below.
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To get excel to auto-complete this row, we now position the mouse cursor at the bottom-left corner of
the rectangle. Make sure the cursor has changed into a + sign. Now hold down the cursor and drag it to
the left till 11.
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Exercise 2
1. Auto-complete cells I8 and 19 all the way to 114.
2. Auto-complete cell E8 all the way to E12.

Formatting

Excel allows you to format your data so that it shows up in the way you need it to. Let us start with
number formatting. Select cells 18 and 19. If you take a look at the Number group in the Home tab on the
ribbon, you will notice that the current number format is “General”:

=rm

TITT R Nl TR T ' s m " H’m
o R = Seam [ | D B Y
i frly PR r = e ] R N | Ll i
| i A EEE R el < R e ) it e g b R
Iimippi il s B o e e

a W R i N & W
el Weiliy  Tediiey  Aebeeh Thoadss Friley  Bglanhey eveley  Mopea s

ﬂ: S —— L P e e e : aih - ar B

.-r.ll..- v T o L i h _:. I'J! -\.I_H .I" *'I :I-III .-F 'ﬂ
Loy STRIIE- S T DT (TR S R e T T
- 3 v [ . 1 -
iy ¥ AAE Y .:1 - E O

a ] T ] ] ] - H a i — 1 @ L] ] L] " n 1
by lamuly bemnp o Wermek maekee rden  lemaisy baelae T s

!

i

q Al ek

i Tl ek

L ! miEpE

i AL

L | i

L] iy I (L=

] o I

() . b N

ik % ' d51

1]

" . I-".J P

£ | s

: 4] - &

1] ]

W

n

Fi

i

L1}

ail

1] n
S RE R T a Fi
L — D TF S ¥ SRR

Lab 1: Excel Basics




.

Select currency from the drop down menu. Now, you will notice that the two numbers have a $ sign

preceding them, and have two decimal places. Let us change the currency symbol to a Euro. Select the
Euro symbol from the currency format menu.
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Exercise 3
Modify cells 18 and 19 by removing the 2 decimal places.

Exercise 4
Format cell E8 so that it looks like August 17, 2010.

Basic calculations

When working on a spreadsheet, you will almost definitely need to perform some calculations on the
data you have. The first thing you need to remember about Excel calculations is that formulas always

start with an = sign. Let us begin with a very simple calculation. Type “=3+5" into cell A5 as shown
below.
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Press Enter. Excel automatically replaces the formula with the result of the equation.

Now let us calculate the sum of the numbers in I8 and 19. In cell J10, type “=I8+19”. One other option is
to type in “=”, then select cell I8. After that, type in “+” and then select 9.
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Pressing Enter will give you the result of the calculation. Double-clicking on the cell with the formula
allows you to edit the formula.

Excel has built-in functions that make your life easier. One of them is the SUM function. In cell J11, type
“=sum(“. Now select both cells 18 and 19.
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Pressing Enter gives you the same result as the plus operation we did in cell J10. Try changing the value
in cell 18 and notice how the change is reflected in both formulas.

Exercise 5

1. Open Sheet 2 in your workbook.

2. Incells A1 and A2, type 1000 and 1500 respectively.

3. Use auto-complete to fill in cells A3 to A8.
Format the numbers so that they show the 1000 separator (1,000) and have one
4. decimal place.

5. Calculate the following values for cells A1 to A8 using built-in Excel functions:
a) Sum
b) Maximum
c) Minimum
d) Average
e) Median
f) Standard deviation

6. Enter the number 5000 into cell A9 and modify all the above formulas to includeit.
Calculate the sum of the Maximum and Minimum, and then divide this number by
7. the standard

deviation.




Charts

Turning data into charts can help visualize the information at hand. To convey the appropriate message
from your data, you need to select an appropriate type of chart for your data.

Let us start out with creating a simple chart using the chart wizard. Open the file excellab2.xslx. In the
total expenses sheet, you will see a table showing the total expenses accumulated by a company in the
12 months of a particular year. Select the entire table.
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On the ribbon, click the Insert tab. There you will notice the Charts group, showing all the different types
of charts that can be created out of the data. Select the 1% option in 2D bars (the clustered bar chart).
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You may need to drag the corner of the chart to make it larger so that all the months are clearly visible
on the y-axis. The chart needs some tweaking. First, we need to decide what extra information we want
the chart to show. We want this chart to have a meaningful title and show a title for the x-axis. We do




o

not need a legend, a title for the y-axis nor data labels. Now that | know what we want, the chart
becomes very easy to customize using Excel’s chart layouts.
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Looking at Excel’s built-in layouts, you will notice that none of them quite satisfy our chart
requirements. Here we have two options. One option is to select one of the layouts and modify it to fit
our needs. For instance, we could pick Layout 6 and simply delete the data labels. The other option
would be to go to the Layout tab in the Chart Tools menu. This tab lets you fine tune the layout of the
chart.

Take a look at the Labels group in the Layout tab. Since we already have a chart title, we do not need to
worry about it. Let us add the x-axis title. Select Axis Titles, then hover over Primary Horizontal Axis Title,
and select Title Below Axis.




R N T R TR

O {7 41 ki ..]'._-I g *r}fuu' ﬂl e Tkl LD e

“a B |l — - - .
= g, | TT M el '|'I'\|'I Ao, ik L g L

- '- I g TR Byl b - L]
5 e ey b P e il i Pl ] I -1 — i
- it i e i v M Ty s b - TR P . - e = = - e
r B ® ] i F R st [t i = | A " ' " Ht

_-..l g ' i —— -
p il Y

I Wi —

[
i=

i hrmsy | s ) vy ik ey
4 ol | F.‘.

i e b | i

B by H

Bl S | Eupemns (3)

N ks whi

T ni | Pamiosin  —

1 st wisia| h::_.“"' L ___________J

b Crlewn LVEE

1:"|l-l-"*- | i "-'.I-':-: —_—

B 1 “ iy ———

£ E Jreer li— AT L
[ ] L]

- | ——

il I:‘:: —

- o my com— i —

t P m IH |U.+ e o
b

47

H

=4

- e T tna - - =TT a

II-I'I-Il'r\III.-I' ] 1 . q { L T 0 i

':I;l.ra"\.l.n.ll |:+|| il !H: :.r .ﬁ "Ii M h—l H I‘J‘ .‘J 'I".I -nl I E’_ I .: ﬂ o

ol s o | Y T e Rl T M T g Y TR

. _l-'l. :'\u_h'\u' L w1 '_ [T i ™h ~ '\-_ e

Barl]. st i

g * o’ # [ [] ® u [ [ ] P o e - - # [ ® wl
i msany ¥ gt |1 |
' B 4] I.I"F

i Ferar 4

i e

1; &

i Bl

L] ane i m_“u'

¥ wi |

B deapadd i — e

i i L1 ST

-I...mu. e [ e — ——

L Nerreilrr HF

s ) — R,

" Ll . B rprrer o[l

) | Bl e— “ -

L e

ul r—f '—r-dh_s_——r

- | o M W Wi e

o s N '.—r;-.r

" 1.+ 9% , |

n v
‘ag ) &)

-'

- » 3 B =
ALK, ""IT"""I'F AT T L S Y . a - e p—L=-l |'ba
R N e’ i e ——

Exercise 1

Remove the legend through the Labels group in the Layout tab. If needed, adjust the chart size so that
all the data are clearly visible.




Now that the layout of the chart is what we want, let us enter the correct titles. Click the chart title and
replace it with “Total expenses for 2009”. Do the same for the axis title and replace it with “Expenses
($)”.
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Now we can play around with the chart colors. Again, Excel allows you to either select one of its
predefined themes or to change the background and colors, one at a time. Select Style 25 from the
Chart Styles group in the Design tab.
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Your chart now looks like this:
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Let’s do a little more formatting. Select the chart area (the box that encompasses the chart title and plot
area). Go to the Format tab and under Shape styles, select Subtle Effect - Purple, Accent 4.
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Now, select the plot area (the area that includes the chart ONLY) and select Colored Outline - Dark 1.
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It is quite easy to change the chart type in Excel. To do this, select the chart area and go to the Insert
tab. Select the Clustered Column from the Column charts menu.
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This changes the chart type as follows:
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Exercise 2

Using the same table, create a 2D pie chart. Instead of showing absolute values, we would like the chart
to show the percentages that each segment makes up as a data label. The month name should also be
part of the label and the legend is not needed. The labels should be at the inside end of the data points.
Make sure the chart has a meaningful title. Adjust the chart size so that all the data is clearly visible.
Give the chart area a black border.

Pivot tables

Pivot tables are used to easily create meaning out of large amounts of data. Let us take an example.
Open the departmental expenses sheet. Select the entire table and then go to the Insert tab on the
ribbon. Click the PivotTable button.
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The dialog box that pops up allows you to modify the range of data to be used for the pivot table, and to
choose where the pivot table needs to be placed. Leave everything as is and press the OK button.
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This is what you should get:
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Let us first take a look at what the different field areas are used for. Their usage will become clear
shortly.

o Values: this is used to display summary calculations in the pivot table.

e Row labels: these labels are used to display fields as rows on the side of the pivot table. The
table is broken down by the first row label; each subsequent label appears as subcategory of the
previous label.

e Column labels: these labels are used to display fields as columns on the top of the pivot table.
Column labels are nested in a similar way to row labels.

e Report filter: this is used to filter the whole report (the pivot table).

The pivot table menu to the right allows you to select the fields you want to add to the table. Select all
of the fields by clicking their respective checkboxes.
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At this stage, the pivot table does not look like anything that makes sense. We need to tweak it a little
bit to show the information we need. Notice that all the fields have come under Row Labels, except for
Expense, which is under Values.

Drag the Expense Type field to Report Filter. Drag the Department field to the Column Labels.




T i . i . = A
- I - 1y E Y |y -
L] = ST o] o e T [ . B T R J-I" ﬁ,
= | I¥ ]
.”. At PR ok WA - | W .E. _’-" . :'._. i s T —= FrAL
i 1o mm i ' o iy ’ ] ik s 1 T - i e -
L1] T B i i B T
[ L] 1 v [ ] ] - 1 ] 1 o [ r ..H.I"-" -
| Toweipe &0 o

A T
8, s [P [ ] N i
i W 140 i iy
F v L LA
[ b i 2
] e (251 ] rrm
n e ™ K . L
. i WY il i
L] ik (B i
n hi# - -
e 160 PR W LEee - ] ] iy sy
" oy [ L] W L i, Pl ol
" . ] . P e — e, =
" by (L] 180
] Ly [ [E=4)
o Pl 1w i i T
W L [ 130 i o
il (L Lkl 1%l I -
o v heia i LA ik e -
]
- E T e
B EES e | T L Sk e e | L # sl T
e Bl

Notice how more meaningful the pivot table has become. It shows the total departmental expenditures
per month, as well as each person’s expenditures in each month. To rearrange the months so that they
are in the correct order, select the cell you want reordered and then move the mouse along the borders
of the cell until a 4-headed arrow appears. You can then drag the cell to its new location.

““ g e o = e - d-Era

Y. ; - R i T - K- 5
T b s A . B G gy LT
r L ol I TR ErEr A ot wrl Faca kit Foras
P 1 A HOEE WD s i'n i L T P T
[ 1] L | e ey S
" E o ] n n = ¥ 1 = 5 L _‘l-.rlh|-|l| s
': Lo T s e g T
B B . [
L e | L [
i ™ = s rm
[ T Ll T T
4 Ll ] R ;
] T il (-
L] [ [[E] L 3]
_ ] L] 1= e |
. R (Lo Laed
1] [ELE (L] (L
L e 1 Em - L] [P ———
it s iE ’ ] !
L] L ] 1dwi = Hip i L
o i el uiv - - —————
i = o] B! 3
o g bl o =
L] L aarh i
e L T
fa) - imm (F.] NN pu et res.
- b1 i ey - i
10 v T Al L g i
L]
] ot T
B S S e ] s et e + s ali STl
= saldZLLE, e

Now assume that we only want the information for Travel and Social expenses. Click on the drop-down
field next to Expense type, and then check the Select Multiple Items checkbox. After that, deselect the
Expense types we do not need and click OK.
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Now, the pivot table shows the information for only the required expense types.
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You can also filter column and row labels in the same way. Excel pivot tables allow for different
calculations of the data value. Currently, the Expenses are being summed up. Let us modify this so that
the table shows the average of all expenses.

In the pivot table field list (to the right of the screen), click on Sum of Expenses and select Value Field
settings from the menu.
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The dialog box allows you to select the calculation type for the data field. Select Average and then press
the OK button.
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The pivot table now shows the average of expenses instead of the sum.
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Exercise 3

Modify the pivot table so that it shows the number of times expenses incurred for each month, per
department and per employee, for all expense types.

Exercise 4

Go to the exercise4 sheet in your workbook. The data in the table shows the population in Canada by
age and sex group for 2009.

a) Calculate the totals for each column and row (hint: try dragging the formula).

b) Make sure all your data shows the 1000 separator mark.

c) Create a meaningful chart out of this table. Make sure you include titles and data labels as
appropriate.

d) Modify both the chart and plot area backgrounds to colors of your choice.

Exercise 5

Go to the exerciseb sheet in your workbook.

a) Format the dates so that they are in the dd/mm/yyyy format.
b) Format the expense amounts so that they show the $ sign (without decimal places).
c) Create a pivot table that shows the total amounts spent on groceries and clothes, by date and

store.




Conditional functions

One very useful set of built-in functions in Excel is conditional functions. As the name implies, these
perform certain operations based when a specified condition is satisfied. This is best illustrated through
an example. Open excellab3.xslx and go to the sheet named conditions. Now, let us use Excel to give us
a count of the number of employees in each department.

For this, we use the function COUNTIF. The form of this function is COUNTIF(Range, Criteria). The range
is the data values you would like the count to be performed on, and the criteria are the conditions that
need to be satisfied for a cell to be included in the count.

Let us count the number of employees in the IT department. Type =countif( and then select the range of
cells we would like to count.

UK u % & e afOUNTI(RERI0 1

L [ C o i ' .
1 Dinp s Dmpartenant Sulary
1 laiml | e a8
B Temi [ 57000
i jhmwy [ Biberritirg FLL O]
B Napaell L] | - aD00h
& Car |iim | xatoo
} Addian [pbasing | apa3
i Heafi {AdvareEryg - | =E00D
g TR |.|rj|;|r|.\,-|||-. FhiRh]
' i Husgun L | Hi0aa
| 11 B, A YT
L3 W |J.E|','||.1 I'|l-i11.l i
i LT il 1T
14
s
| Lo
Il if -
Irl + .F. & pomdiliens ! Aty & iy oy, | A L ] L

ll il _,Il-r_'F

Now we need to enter the criteria.
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Note that IT was placed between quotation marks, as should any criteria you enter. When you press
Enter, the result of the formula is shown.
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Exercise 1
a) Calculate the number of employees in the Accounting department.

b) Calculate the number of employees with a salary greater than 15000 (remember the quotation
marks around the entire criteria).

Now let us try using a cell address as a criterion. We would like to find the number of employees who
have a salary greater than Reagan’s salary. The only difference here is that to include a cell address in
the criterion; there is a special syntax as shown below.
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In other words, the operation symbol remains between quotations and then the cell address is
appended to it using an ampersand (&).

Exercise 2
a) Calculate the number of employees who are NOT in the IT department. (hint: the not equal sign is
<>)

b) Calculate the number of employees with a salary greater than or equal to Alexis’, and less than
Trey’s. Remember to use cell addresses. (Hint: use two countif operations.)

SUMIF works in almost the same way as COUNTIF, except it returns the sum instead of the count. For
instance, let us calculate the sum of all salaries greater than 15000.




Ao RO
= T ik ] =iy P R £ j
el e B YA R W 8 o T al A
T g L | ¥ [ Ta | e g |
y o ple g .'. ! iz |I.|-.|- .| Lot @1 | 1| i . i
. :w & -Hﬂln:ﬂm.'-mm" . ____B
il i =1 C [ e ¢ u g
b T iy e il J!“.'"ﬂ'. It
I Aaiam i 15500
1 Tray ir [ 1imn
4 Earay hdbvwtlaing | LhDOE
& dsndel (] | ppoen
B G KR [ L
¥ Aggiaen Mg anneg iemg
[RETTLA Asvsrilng | LeDo
B Al dgpninling | LieE i
01 Ewagan I | leooe
11
A1k |e i 1 wumeind [RETRIRED C10 mlb00)
11'1-n ¥ .ml.l.bl.--h-,- P lru-l-l
AN 1-h i I,
1N el gas |
L] 1]
17 . £ : i -
| LALBALGE L L S R T (. o~ e
lun L

- —— a.rl e

SUMIF also lets you define separate ranges for the criterion and the summation. For example, we might

want to calculate the sum of all salaries of the IT department.
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As you can see above, we first provide the formula with the range of values on which the criteria will be
applied. We then enter the criteria, followed by the range which is to be summed up if the criteria apply

to the 1™ range.

Exercise 3

a) Calculate the sum of all salaries that are below the average of salaries.

b) Calculate the sum of salaries of the HR and Accounting departments.

c) Using AVERAGEIF, calculate the average of all salaries that are less than or equal to Stacey’s.

IF functions

IF functions or statements allow you to ask the question “is this true or false?” It then allows you to
implement different actions based on the outcome. That is, it allows you to compute two different
outcomes based on whether a certain criterion (logical test) is true or false. The format of an IF
statement is as follows:

=IF(logical test, value if true, value if false).

In excellab3.xslx, open the if statements sheet. The grades shown are for a pass/fail course, with the
passing grade starting at 60. Let us use IF statements to display which students have passed, and which
have failed.

First, start with the logical condition that needs to be evaluated. In this case, a student passes the course
if her/his grade is greater than or equal to 60, say. The symbol >= means greater or equal.
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After we formulate the logical test (the student’s grade is >= 60), enter what we want Excel to display if
this condition was true. In this case, we want Excel to display “Passed”.
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Finally, enter the value if the condition is false. The IF function shown below reads: if B2 is greater or
equal to 60, then display Passed; otherwise, display Failed.
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Now, drag the cell with the formula into the rest of the column.
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Exercise 4

The instructor for this course would like to reward the students who got a grade strictly above 85. Use if
statements to display “Reward” or “No Reward” beside each student.

Now what happens if this course was not a pass/fail course, rather one with a letter grading scheme?
This requires the use of nested IF statements. Nested if statements allow you to embed IF statements in
other IF statements, capturing more complex scenarios. Assume that following is our grading scheme:

>90
>75
>60
otherwise

mioO|w|>

Nested IF statements are done by replacing the value if false or the value if true in the function with a
new IF statement.
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Notice that the logical condition of the IF function is similar to what we had done before: we require the
grade cell to be greater than a certain value. Specifically, if B2>90, the Excel displays the letter mark A. If
this condition is false, or B2 is less than or equal to 90, we need another IF condition in order to
determine the letter grade since values that are less than or equal to 90 can result in different letter
marks. For example, 77 isaB, 65 isa C, and 20 is F. All these values are less than or equal to 90.

Let us complete the entire function:
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Notice that with each new IF statement, we opened up new parenthesis and that at the end we had to
close all of them. Drag the IF statement into the rest of the column.
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The following flowchart depicts how this IF function works.

I =IF{B2=80,"A" IF{B2>75,"B" IF(B2>80,"C" "F"}))

E| Print “A”

Print “B” False
Is grade
>607?

If B2>90, the A is displayed. If this logical condition is false (B2 is less than or equal to 90), a new if
function takes effect: IF (B2>75,”B”,IF(B2>60,”C”,”F™)). In this function, the logical test is B2>75, the
value if true is B, and the value if false is another if function: IF (B2>60,”C”,”F”). Hence, if B2>75 is true, B
is displayed. If not, we need to check the mark ifit isa C or an F. If B2>75 is false the last if function takes
effect: IF (B2>60,”C”,”F”). If B2>60, display 60; otherwise, display F.

Print “C” Print “F”

Exercise 5

Open the if exercise sheet. The sheet shows the names of salespeople along with the revenues they
have brought to the company. Using if functions, calculate their bonuses based on the following
scheme:

>=$15000 | 10% bonus
>=$10000 | 8% bonus
>=$7000 5% bonus
otherwise No bonus




Lookup functions

You may have noticed that some of these if statements can get quite long. An easier way to match up
the grades to their corresponding letter grade is to use the LOOKUP function.

The first thing you need to do is to create a lookup table that displays which numerical grades
correspond to which letter grades. This is the grade distribution:

A >=90
B >=80
C >=65
D >=50
F otherwise

Open the lookup sheet.
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Notice that the lookup table is in ascending order (by the first column). It must be in ascending order for
LOOKUP to work. The way this table is interpreted is that we are providing Excel with the minimum
numerical grade for each letter grade. For instance, the F grade is between 0 and 50 (since a D starts at
50), not including 50. The A grade is anything greater than or equal to 90. If we had not set the minimum
numerical grade for F as 0, any value below 50 would return an error.

Now let us put this table into action, using a LOOKUP function.
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The first parameter we give the lookup function is the value to be looked up, which in this case, the
numerical grade. The second input is the lookup table. Now drag the function to the rest of the column.
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As you can see, we received plenty of error values. Double-clicking one of those values will show you the
problem. When we dragged the formula, the address of the lookup table was incremented. Therefore,




we need to fix the lookup table address in the formula. The way this is done is by adding $ as prefixes in
cell addresses. The $ sign before a column name or a row number signifies an “absolute” or fixed
address. When the formula is copied, Excel does not change absolute addresses. To the contrary, the
reference D2 is called a “relative” address. In essence, it is saying lookup the value immediately to the
left of cell E2 (where the lookup function is created) and go from there. So, when the formula is copied
from E2 to E3, D2 will be updated to D3. Lookup tables should be always referenced in an absolute way.
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A shortcut to do this is by clicking on F4 right after selecting the lookup table. Now try dragging the
formula again.
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Now it all looks good, and as you can see above, the address of the lookup table was fixed.

Remember:
- The lookup table must be in ascending order.

- If lookup cannot find the exact match to the value you provided, it will return the result
corresponding to the largest value that is less than or equal to the value you provided.

- If the value you are looking for is smaller than the smallest value in the table, an error value will be
returned.

Exercise 6

The following table provides the color frequencies in the visible spectrum
(http://en.wikipedia.org/wiki/Visible spectrum).

Color Frequency (THz)
Violet 669-789
Blue 631-668
Cyan 607-630
Green 527-606
Yellow [ 509-526
Orange | 485-508
Red 400-484

In the lookup exercise sheet, fill in the colors corresponding to the given frequencies using the lookup

function.




Conditional formatting
Conditional formatting allows you to make data trends stand out visually.

Open the file excellab4.xslx and navigate to the condForm sheet. Let us say we would like to quickly
view who has OT (Over Time hours) more than 10 hours.

First, start by selecting your data range:
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In the Home tab, click on Conditional Formatting in the Styles group. Move the mouse pointer over
Highlight Cells Rules, and then click Greater Than.
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In the dialog box that pops up, Enter 10. Notice that you can modify the way that the cells are formatted
by choosing the fill and text colors from the drop down list labeled with. For this exercise, leave the
formatting as light red for the fill and dark red for the text. Click the OK button when you are done.
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Now, OT hours that are greater than 10 have been highlighted.
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Exercise 1

Highlight the Hours that are in the bottom 20%. Format them so that they have a Yellow Fill with Dark
Yellow Text. (Hint: use Top/Bottom Rules).

Other conditional formatting features allow you to get a quick overview of the values of all cells in a
range. One of them is data bars. Data bars assign the longest bar to the largest value in a list and the
shortest bar to the smallest value. The values in between are then given bars according to their
respective values. Let us apply this to the Total column.

Select the range of cells under the Total heading. Click on the Conditional Formatting button and
navigate to the Data Bars menu. Select the Purple Data Bar button.
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The data bars now provide you with a quick relative view of the total amounts employees earn.
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Using color scales also gives you a similar result as data bars. Both features allow you to get a quick view
of how your data values compare to one another. The 2-color scales assigh one color to the maximum




value and another to the minimum. The values in between get assigned “in-between” colors. In
addition, the 3-color scales assign a color to a selected midpoint. The colors and values assigned to them
can be modified by selecting Manage Rules under the Conditional Formatting header.

You can also delete rules by selecting the cells where you would like to clear the rules, then navigating
to the Clear Rules menu under Conditional Formatting. Click on Clear Rules from Selected Cells.
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Exercise 2

After you have cleared the data bars rule from the Total column, apply the Green-Yellow-Red color
scale.

Exercise 3
Edit this rule so that the maximum value is shown in a pretty sky blue color.

The final aspect of conditional formatting we will cover is icon sets. When using icon sets, each cell is
provided with an icon depending on its value. There are no gradients in icon sets.

Let us format the Rate column using icon sets. Select the cells in the Rate column and apply the 3 traffic
lights (rimmed) formatting to them, as shown below.
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As you can see below, Excel assigns the icons based on its own calculations.

ARSI N ut e :.V\wl"'\ﬂ
: DA | 11 L
Yl erunlavey AN A Mmoo s

v e

(e " (o o3 o W mpiny S Gow | A it % A N

oot RO RET LB KIS R IR oty ﬁl}tﬂ

& .A- ;’ » L 'J '{s ’ \-n"'”‘f' < M Seali

S s Siiiie R RO i p_
o e AL

L €k e

i b 4

§
§

»
,

it

ol
£38
:

5

sryrairssstss

LSEFSSEEE
¢
.

‘:

3% ooemitorm . e 04"
A

If you want to change the way that the icons are assigned, you need to edit the rule (Manage Rules). As
you can see below, Excel is currently assigning the Green icon to values >= the 67 percent. What this




means is that Green icons will be assigned to values >= 67 percent between the lowest value (8.5) and
the highest (15). In this case, the minimum value associated with 67 percent is 0.67*(15-8.5)+8.5. This is
12.9. In other words, Excel calculates these percentages by assigning 100% to the highest value in the
range and 0% to the lowest.
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Let us change the type of values to Percentile instead of Percent.
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Notice the changes in the distribution of icons.
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Percentiles do not calculate the percentages within ranges of values. Percentiles are based on the order
of a value among the other values. Values <= the 33 percentile means that red icons will be assigned to
the bottom 4 values. If you are interested in the Math, this is because 0.33*13 (the number of values) =
4.29.

What you need to understand about this is that percentages are calculated relative to the lowest and
highest values when percentiles are calculated based on the position of a value in the ordered list of
values.

Exercise 4

Format the OT Rate column using the 3 flags icon style. The cells should show a RED flag if its value is
>=20, a YELLOW flag if its value is <20 and >=15, and GREEN otherwise.




Sorting lists

Sorting a list or sorting an entire table are both functions that will most likely come up whenever you are
doing data analysis. You can easily sort data in alphabetic, numeric, or even chronological order.

Let us try sorting our table by the ascending alphabetic order of the names of the employees. Select the
range of names in the table. Then in the Home tab, under the Editing group, select Sort A to Z.
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A warning message pops up:
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What this message is telling us is that with the current selection, only the names column will be sorted.

The data in the rest of the table will not be sorted. This is why we need to select the “Expand the
selection” radio button. This will allow the entire table to be sorted according the alphabetic order of
the names. Press the Sort button. The entire table has now been sorted.
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Exercise 5
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Sort the table through the Hours column, from largest to smallest.

Excel also lets us perform more complicated sorting. Let us try to sort the table by the cell icons of the
Rate column.

Select the entife’ féb1e. Under Sort and Filter, select Custom Sort.
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The custom sort dialog box pops up.
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This dialog box shows the column headers in our table, how we want to sort them and what order we
want them in.

Select Rate as the Sort by column, and then select for it to be sorted on Cell Icon. The order menu now
shows the three icons used in the Rate column. Let us ask for the green icon to be placed on top, as

shown below.
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Now we can add another level of sorting so that the red icon is at the bottom. Click on the Add Level
button in the dialog box. Select Rate and Cell Icon again. This time, make sure the red icon is ordered on
the bottom, and then click the OK button.
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This is what your table should look like:
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Exercise 6

Use custom sort to sort the table in the descending order of the OT Rate and then in ascending order of
the names of the employees.

Filtering lists
Filtering in Excel allows you to show only the rows of data you are concerned with, and hide all other
“data temporarily.

Open the filters sheet in excellab4.xslx.

One obvious use for filters here is to view the sales information of only a few regions of interest. Let us
see how this can be done.

Start by selecting the Region column. Under the Home tab and in the Editing Group, select the Sort and
Filter button. Select Filter from the menu.
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Notice that there is now an arrow next to the Region header. This arrow means that a filter can be
applied to this column, but no filters are currently being used.
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Click the arrow next to the Region header. Let us only show the data for sales in the East region. One
way to do this is to deselect NW and SW as shown below.

'ﬂ‘q-n\'ff‘r "'G‘S‘-*wm « Microiof bare — . < W
_ v Shu- 't.c &-W Tumrie ..3 e “4- Nw " X A"'h“o“fﬂ
. ¢ . g - lf".’.nln.-.n-.n.w.— My + x- v Il
A can AN eigle g M .
—J 4‘| ‘- ‘ ‘ . uf.runu'll‘-' rl‘d“‘f‘ { 9{ la )

t F‘y‘" ¥ 'l ‘ U' ' h'&' -8 8 B Xl S ..'-‘ : %..ib\ln- "m',rn.“ J :L* ""':: "
VLA > M. o S A et i po = =) iy &
I . o Sagor vl
L& A A 'i'__'_io (TS 5 N | W S T T ) ':'

1 Salevpernan Dete Joined [ Jaatee ‘
., B A $12.400

P N owetina 410,600

Ity e s | 512,000

l-’u % Wl ”m

£ 315,400

1_ ' "1 %2000

’}”. et Ly Ll u’.‘m

B S Pl ohem

L o wive AT, H4IAN

1 - 414,509

1 Aed |

1 v

‘. a l\f

L 3

10 o ) | e

17

u |

LN NC - 1 R S R 41
.% ——n _ — jﬂ&!&—mm.n —.—4—6.;:’.’

Now, only the rows showing information from either the NE or SE are shown. Notice the button next to
the region header has changed to a filter icon indicating that a filter has been applied.
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There is another way by which the same result can be achieved. First let us remove the applied filter.
Click on the button next to Region and select “Select All”. Click the OK button.
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Now that we can see our original data, let us add a new filter. Select the arrow next to Region and move
the mouse cursor over Text Filters. Choose Ends With.
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In the dialog box that pops up, enter E as shown below. This will only show the rows in which the Region
ends with an E. Click on the OK button.
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Now let us remove the filter by cllckmg on the button next to Reglcm and selecting Clear Filter from
“Region” from the menu.
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Exercise 7

Create a new filter that only shows the data for salespeople who have joined after May 2004, and
before or during May 2008. Filter this further so that it only shows the ones who have sales less than
$6000 or greater than $12000.

Exercise 8
Remove the previous filters from the table. Show only the rows from the months April, May, and June of
all the years (an quarter). From those rows, only show the ones with Sales above the average.




Drop-down lists

Drop-down lists are useful in making data entry easier and faster by limiting the number of options to
pre-defined items.

Open the file excellab5.xsIx and navigate to the dropdown sheet. The sheet shows a partial table of
students in a class. We would like to limit the possible valid entries into the major column.

First, we need to create a list of all valid majors that will be accepted. Here are a few that one can think
of. Feel free to add your own major if it is not in the list.
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Nex,t we need to name our list. Select the list of majors that was created. Go to the Name Box at the left
of the formula bar (shown in a red square below) and type in an easy to remember, descriptive name of
the list, such as ValidMajors.
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To create the drop-down list, first select the range in which the list will be used (see the illustration
below). Then under the Data tab, select Data Validation from the Data Tools group.
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Go to the Settings tab in the dialog box that pops up. In the Allow box, select List. We need to pick the
data source for our list. You can either enter = followed by the name of the list that was defined
previously, or you can use the arrow to the right of the Source field to select your list manually.
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You can also ask Excel to show an input message describing to users what they need to do. Go to the
Input Message tab and enter an appropriate title and input message:
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We can choose whether we want to restrict the user’s entries to the list, displaying an error message on
any other entry. To do this, go to the Error Alert tab. Excel lets you pick the style of the error message,
as well as the message title and body.
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When you are done entering everything, press the OK button.

Now when you click on a cell in the Major column, you get an arrow indicating a drop-down list is
available, as well as the input message we had provided. Try entering a major that is not on the list. You
will see an error message.
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Exercise 1

Create a drop-down list for the Gender field. The list should show a warning message on invalid data
entry. No input message is necessary.




Exercise 2

Create a drop-down list (freshman, sophomore, etc.) for the Year column with an error message. The list
should not allow blank entries.

OFFSET fu

nction

The OFFSET function allows us to start somewhere in the spreadsheet, move in any direction in order to
locate a cell or a range of adjacent cells, and return the value of this cell or a set of values for the range

of cells. The general syntax for this function is:

OFFSET(reference, rows, cols, height, width)

where;

o Reference: is the address of a cell or a range of adjacent cells

e Rows: is the number of rows to move from the reference. A positive number means moving
down, and a negative number means moving up from the reference.

e Cols: is the number of columns to move from the reference. A positive number means moving
right, and a negative number means moving left from the reference.

e Height: is an optional positive value indicating the number of data rows to be returned by the
function.

e Width: is an optional positive value indicating the number of data columns to be returned by the
function.

Let us understand how to use the OFFSET function through an example. Open the dynChartsl sheet in
excellab5.xIsx. In an empty cell, type =OFFSET(A2, 1, 1, 1, 1) and press Enter.
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The value returned is -6 since the function reads as follows: move one row down (first 1) from cell A2
and one column right (second 1) of cell A2, and return a single cell. A height and width of 1 (third and
fourth 1s, respectively) indicate it is a single cell that we are offsetting to. This is cell B3, which contains -
6, the returned value. When both the height and width are 1s, these arguments can be simply left out.
For instance, OFFSET(A2, 1, 1, 1, 1) is equivalent to OFFSET(A2, 1, 1)

Try this one: =OFFSET(BS, -3, -1). Starting at cell B5, move 3 rows up and 1 column left. The size of the
returned data is also one cell (since height and width are omitted). The offset is A2 and the value
returned by this function is Jan.
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In order to specify a height or a width that is greater than 1, the OFFSET function must be used in
another Excel function, such as SUM or AVERAGE. If you attempt to use it on its own, you will get an
error message. For instance, if you type =SUM(OFFSET(A1, 1, 1, 5, 1)) in an empty cell, you will get an
error message.

OFFSET(A1, 1, 1, 5, 1) refers to a range of adjacent cells, starting at A1, moving one row down and one
column right this will take us to cell B2. B2 is the top left corner of the required range of values. The
range of cells from B2 spans 5 rows and 1 column. Recall that height and width must always be positive.
Hence, OFFSET(AL, 1, 1, 5, 1) returns B2:B6 or all the average temperature values in the sheet.

Now, use OFFSET in a SUM function and type the formula: =SUM(OFFSET(A1, 1, 1, 5, 1)). Here we are
adding all the temperature values together.
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Now what if we want this SUM value to be updated whenever we add a new month’s value? Of course
one way is modify the formula SUM(OFFSET(AL, 1, 1, 5, 1)) to include the newly added month. However,
this is cumbersome. We would like this to be done automatically and without changing the formula that
contains the OFFSET function. A combination of OFFSET and COUNTA can be very powerful.

COUNTA is a count function which counts all non-empty cells in a range. We can use it to count all non-
empty values in Column B as such: COUNTA($B:$B). Our new formula is:

=SUM(OFFSET(A1,1,1,COUNTA($B:$B)-1,1))

The range of the OFFSET starts at A1, moving one row down and one column right. That is, the top left
corner of the required range of cells is B2. B2 contains the first temperature value. The height of the
range is COUNTA($B:$B) — 1, which is one less the number of non-empty cells in column B. Remember
that the column title (Average Temperature (OC)) is a non-empty value, but it should not contribute to
the number of values we are trying to sum up. Hence, COUNTA($B:$B) — 1 evaluates to 6 — 1, which is 5.

The returned value of the SUM function is 0, the 5 temperatures in column B cancel each other.
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The SUM(OFFSET(A1,1,1,COUNTA($B:$B)-1,1)) function automatically includes the June value (13.5) in
the sum since column B contains a new non-empty value now.




Dynamic charts

In this section, we will take a look at how to make a chart that dynamically updates its values. Data is
dynamically added to charts by using the OFFSET function. Start by deleting the SUM formula that was
created previously. Remember how we named a range of cells in the drop-down sheet? This time we
will be naming formulas.

Go to the Formulas tab and under the Defined Names group and click on Define Name.
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Enter the name, Months. In Refers to, type in the formula that refers to the Months column as shown
below. Type carefully. If you want to check if the range you entered is correct, click in the comments
field then back in the Refers to field. The range should be highlighted in your worksheet. When you are
done, press OK.
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Note that a cell address can be prefexed by the sheet name in which the cell is contained followed by
the exclamation mark (!). For instance. dynCharts!$A$2 referes to cell A2 in dynCharts. The address
A$2$ is absulote (fixed).




Exercise 3
Create a Name (Temps) for the temperature column.

If you need to view or modify the names in your worksheet, click on the Name Manager in the Defined
Names group.

Now that our formulas are ready, we can create the chart. In the Insert tab, under the Charts group,
select 2D line. Make sure no cells are selected while you are doing this. A blank chart is created. Right-
click the chart and click on Select Data.

We now need to decide which column we would like to see on the vertical axis and which we would like
on the horizontal one. Let us place the temperatures in the vertical axis.

Click on the Add button under Legend Entries.
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The Series name is the name of the vertical (y) axis values. In this case, it is cell B1. The series values are
the Temps formula we created. To refer to this formula, you must first type in the sheet name it was
created in, followed by an exclamation mark. Otherwise, Excel will not know where to find this name.
When you are done, press the OK button.
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Now press the Edit button under Horizontal (Category) Axis Labels.
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Next, on the Select Data Source dialog box, press the OK button. Your chart should look like this:
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Try adding new data to the table and watch how the chart gets updated.
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Note that in the dynamic chart we created, because the average temperatures for some months are

negative and the x-axis crosses y-axis at the temperature of 00, the x-axis appears in the middle of the
chart. If you want to move the position of the x-axis, open the Format Axis dialog by right-clicking on the
y-axis as shown below.
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In the Format Axis dialog box that appears, under “Horizontal axis crosses”, enter “Axis value” to be the
lowest temperature value along the y-axis, which is —10. Press the Close button when you are done.
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Now the chart will look as follows:
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Exercise 4

Sheet dynChartsEx shows a table that shows where money is being spent. Create a pie chart which
shows how the money is spent. The chart should be updated automatically whenever a new expense is
added.




Using combo boxes to create dynamic charts

Using combo boxes, we can allow users to select which data they would like to see on a chart. First, let
us see how we can make a combo box. The difference between the combo box we use in this lab and
the one we have seen in the last lab is that this combo box is not used to enter data into cells. It is used
to let the user interact with the worksheet as a form.

Open excellab6.xslx and navigate to the comboBox sheet. Under the Developer tab, in the Controls
group, press the Insert button, and then select Combo Box from the menu.

VD AT N i W Vool il ",‘W'

” Woww .....‘- .'v-iiv\-' '-llll W ‘.‘q‘ ‘h .- '-- . . fue -y o o 5 , :"
1L Loy p -

M -nq 2 owd Aspons R 1'_\ e (A = v a\] ’: oot o\
g ow WM e r ’ .\” ﬂ‘ o F/w-u' Podn %0

T ER e
\u“ “ e 2t cOr e 3 2 T, LAaeridn !I
oy LR R At - :.._.'. ' Yo lamy Poriet
{ e R ke Ry o et 1
| -y PRITED
| AR R | =€ o ‘...xfn .:‘ :- : —— ’
t T I T R i LR ¢ =
2 Quics 200 ™ "
3 Ih "y
PR » w 100 ' VAR
LAyl n L 80 u
5 Oust " " 0 5
e
0
Iy
z LA A |
PN cambalion 54 13 | T ueemeen | 3 el
T Mt Gl d "'u Al - L ol
—_— T —— e - - g —— -

Next, drag the cursor and draw the combo box onto your sheet.
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To populate the combo box with data, right-click on the combo box and select Format Control from the
menu.

In the control tab, place the cursor in the Input Range field, then select the A2 to A5 from the sheet (or
just enter the cell references yourself). The data in these cells will populate the combo box.

The cell link is the cell in which the result of the the combo box selection will be displayed. Select any
empty cell in the sheet . We are going to select cell 13 as the cell link. When you are done, press the OK
button.
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Try the combo box. Notice how cell I3 changes to reflect the index of the selected item in the combo
box. :
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Exercise 1

Using names and OFFSET, modify the combo box so that the list of quizzes gets updated whenever a
new one is added. Use the name Quizes for your formula.

Exercise 2

Create another named variable called SelectedQuiz, which points to the quiz name currently selected in
the combo box (hint: use the combo box cell link and OFFSET).

Exercise 3

Create a named variable called Students that points to the names of the students in the table. The list
should be updated when a new student is added (hint: just like counting cells in a column is done
through COUNTA($B:$B), counting cells in a row can be achieved by the formula COUNTA($1:$1)).

Exercise 4

Create a named variable called SelectedGrades. This should refer to the array of grades of the selected
quiz selected in the combo box.

After you are done with the above exercises, it becomes easy to create the chart. Without any range of
cells being selected, create an empty 2D column chart. Right-click the chart and select Select Data from
the menu.

Click on the Add button under the Legend Entries heading.

A good idea for the series name would be the name of the current quiz selected. The series values
should be the selected grades. Do not forget to enter the name of the sheet first, as shown below. Click
OK when you are done.
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Obviously, the horizontal axis should contain the names of the students. Click the Edit button under the
Horizontal (Category) Axis Labels and mention the “Axis label range” as shown below.
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Press the OK button on both dialog boxes when you are done. Now, try changing the selected quiz in the
combo box and see how your chart changes.
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Using check boxes to create dynamic charts

Check boxes are a better choice than a combo or list box when we need to select more than one option
for our chart. In the Developer tab, under the Controls group, press the Insert button, and select Check
Box. It is much more difficult to make a new check box dynamically when you add a new item.
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Draw the check box into your sheet. Change the text to Quiz 1. If you need to do this later, right-click the
check box and select Edit Text from the menu.

Repeat this three more times, changing the quiz number each time.
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Right-click the 1% check box and select Format Control. Just like we did with the combo box control, we
need to set the cell link for each check box. This cell will display TRUE or FALSE values, depending on
whether the box is checked or not.
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(

Create cell links for all the other check boxes. Try checking and unchecking the boxes and notice how the
cell links change.
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At this point, we need to create a named variable for each of the check boxes. Click on the Define Name
button in the Defined Names group under the Formulas tab.

The first formula we are going to enter is for whether or not we need Excel to plot Quiz 1 values.
Obviously, since this requires TRUE/FALSE decision making, we need to use If statements. The if

statement shown below checks the cell link for the 1°* check box, if it is true, it returns the quiz grades
for quiz 1, otherwise it returns a 0.
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Exercise 5
Create named variables for the rest of the check boxes.

We also need to create named variables for the series titles. The if statement returns blank if the box is
unchecked.
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Exercise 6
Create named variables for the rest of the series titles.

Insert a blank 2D line chart into your sheet. Just for the time being, make sure all your check boxes are
checked; Excel will return error messages otherwise. Right-click on the chart area and click on Select
Data. Press the Add button under the Legend Entries header. The series hame here is the Quiz 1 title
variable. The values are the Quiz 1 values. Remember that both will return blanks or zeroes if the Quiz 1
box is unchecked.
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Exercise 7

Add 3 more legend entries to the rest of the check boxes. Remember to click the Add (not Edit) button.
When you are done, set the Students as the Horizontal Axis Labels.

Following is what your chart should look like:
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Try unchecking some of the boxes to see how the chart changes.

What's next?

This is only the beginning when it comes to dynamic charts. You can use different controls, such as scroll
bars, list boxes or even a combination of many controls. You will need to go beyond what we covered in
this lab to master Excel. This lab was only meant to provide you with a starting point.

There are times when it may be more useful to use Data Validation lists rather than the combo boxes we
used in this lab. In this case, you can always look up the index of the selected list item using the MATCH
function.

Remember there are many different ways to create cool and useful charts in Excel. You are only limited
by how much you are willing to learn and how much effort you are willing to put in.




